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Organisations in virtually every industry sector rely on their IT systems to conduct business. The IT departmentôs 
ability to resolve technology issues and manage the ever -changing IT infrastructure is critical to support business 
goals. Bellerophon Helpdesk automates many aspects of call  management , increasing efficiency which allows staff to 
focus on problem resolution. The solution is easy to deploy, in days, not weeks -  and is affordable for organisations 
that need a quick start in service management.  

BELLEROPHON HD  is built on the same  BELLEROPHON EMS II  platform as our more comprehensive enterprise  
solution,  Organisations  that have a helpdesk requirement today can be confident of investing in a solution that can 
grow as business needs change.  

 
BELLEROPHON HD  Helpdesk  software automates many aspects of call and trouble ticket management, increasing 
efficiency, and allowing the help desk to focus on support & problem resolution.  

In order for today's businesses and organizations to maintain and improve customer service and optimize  help desk 
staffing levels your  help desk software must help you create.. . an efficient,  cost effective  customer focused 
support environment!   

 
Whether you currently track support requests on paper or spreadsheet, or have help desk software that is no longer 
adequate for your current needs, we invite you to take a look at our Bellerophon HD Help Desk Software  which 
enables you to provide a cost effective network based solution.  

 

Fully -automated call management, prioritization, ownership and audit trail.  

 

Fully -automated email integration with shared mailbox support.  

 

Resource scheduling and calendaring are standard.  

 

Knowledge Base for common problems and solutions.  

 

Full rights management to control the access and use of the solution by technicians 
and customers.  

 

Comprehensive reporting environment with graphics and real - time report options.  

 

Fast and easy to install, configure and deploy.  

 

Fully -customizable table schema and user interface  
 

Fast to Deploy, Easy to Configure  

Bellerophon HD Helpdesk software  provides the optimum combination of call management automation, 
functionality and flexibility, delivering a comprehensive help desk solution that satisfies most   Helpdesk 
requirements right out of the box. Built on Bellerophon (Enterprise Support Platform ),  BELLEROPHON HD  
allows the customer to pick and choose the elements of the solution required to meet precise needs.  

Unlike othe r IT support software,  BELLEROPHON HD  is non -prescriptive and can be configured to meet additional 
business processes not stri ctly defined within a conventional IT Helpdesk environment, thus providing ultimate 
flexibility.  

Business Benefits  

 

Streamline and automate your customer service requests.  

 

Improve customer satisfaction.  

 

Increase the productivity of your IT support staff.  

 

Lower the cost of your IT support service.  

 

Reduce technician training time with a familiar look and feel.  

 

Easily integrate, out of the box, with many common Network and Desktop management solu tions.  
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0. This Help Desk manual will give you an understanding of Bellerophon HD. The Help Desk can be divided into 

three categories, setup, functional and informational.  Here is a brief overview of how each section of the Help 

Desk fits into each of these categories. 

 
Setup 
 
The setup screens are where static information pathways are created in order that other screens can work 
correctly. These screens allow you to 

¶ Setup unique departments on individual helpdesks, with specific fields and data capture points per 
department.  

¶ Setup custom fields including, text boxes, picking lists, drop downs  

¶ User access per department, but I.T. departments can access each helpdesk  

¶ {ŜǘǳǇ ŀƴŘ ŎƻƴŦƛƎǳǊŀǘƛƻƴ ƻŦ {[!Ωǎ ōŀǎŜŘ ƻƴ ǎŜƭŜŎǘŜŘ ŎǳǎǘƻƳ ŦƛŜƭŘǎ 

¶ Configuration of departments including job completion targets and additional email footers 

¶ Enable or Disabled departments 
 

An example of these types of screen is Maintenance 
 

Functional  
 
The functional screens are where business process actions are carried out within the module. These screens 
allow you the 

¶ Jobs can be assigned to an individual and alerts and requests are sent via optional emails  

¶ Jobs can be updated and a full and complete audit trial is tagged to the job. This included information 
regarding what was done, the time it was carried out and by whom  

¶ WƻōΩǎ Ŏŀƴ ōŜ ǊŜŀǎǎƛƎƴŜŘ ōŀŎƪ ŀƴŘ ŦƻǊǘƘ ǘƻ ǾŀǊƛƻǳǎ ǇŜƻǇƭŜΤ ǘƘŜ ŀǳŘƛǘ ǘǊŀƛƭ ƛǎ ǳǇŘŀǘŜŘ ŀǳǘƻƳŀǘƛŎŀƭƭȅ  

¶ The jobs can be filtered by both the standard fields and the custom user defined fields  

¶ Documents can be attached to individual jobs and can be retrieved at any time 
 
An example of these types of screen is Jobs 
 
Informational 
 
Finally, the informational screens are where data can be manipulated and viewed for managerial and analytical 

purposes. These screens allow 

¶ Statistical information about the success of failure of jobs completed in time.  

¶ Individual users can be monitored and their progress compared to others in a league table  

¶ Graphical charts depicting the percentage of jobs completed on time versus, overdue jobs and 
overdue jobs completed after the estimated due date has been changed to monitor anomalies.  

¶ Jobs can be plotted in an Outlook style calendar interface for easy viewing of the day, week or months 
tasks.  

 
Some examples of these types of screen are Scheduler and Management 
 
Unique Points about the Help Desk module are 
 

¶ The ability to completely customise the helpdesk and setup departmentally specific screens.  

¶ The helpdesk is linked into the system and users can directly log jobs without the need to call up in 
person 
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0.1 Installation 

 

0.1.1 Bellerophon HD installation 

 

Run Install.exe as administrator 

 In Windows Vista  wƛƎƘǘ ŎƭƛŎƪ ŀƴŘ ŎƭƛŎƪ Ψwǳƴ ŀǎ !ŘƳƛƴƛǎǘǊŀǘƻǊΩ 

 In Windows XP  wƛƎƘǘ ŎƭƛŎƪ ŀƴŘ ŎƭƛŎƪ Ψwǳƴ ŀǎΦΦΦΩ 

    {ŜƭŜŎǘ ǘƘŜ Ψ¢ƘŜ CƻƭƭƻǿƛƴƎ ¦ǎŜǊΩ radial selection 

    Enter the administrator log in details 

Accept that you wish to install Framework .net 3 and SQL Server 2005 Express 

{ŜƭŜŎǘ ŀ ƭƻŎŀǘƛƻƴ ǘƻ ƛƴǎǘŀƭƭ ǘƻ ǳǎƛƴƎ ǘƘŜ Ψ.ǊƻǿǎŜΩ ōǳǘǘƻƴ 

/ƭƛŎƪ ǘƘŜ ΨLƴǎǘŀƭƭΩ ōǳǘǘƻƴ 

When it asks if you wish to instaƭƭ ǘƘŜ ŀǇǇƭƛŎŀǘƛƻƴ ŎƭƛŎƪ ƻƴ ΨLƴǎǘŀƭƭΩ ŀƎŀƛƴ 

You should now see the log in screen 

Make sure the options are visible 

tƭŀŎŜ ŀ ǘƛŎƪ ƴŜȄǘ ǘƻ Ψ/ƘŀƴƎŜ {ŜǊǾŜǊ bŀƳŜΩ 

Enter MYCOMPUTER\SQLEXPRESS (where MYCOMPUTER is the name of your computer) 

Leave the Username and Password blank 

/ƭƛŎƪ ǘƘŜ Ψ[ƻƎƛƴΩ ōǳǘǘƻƴ 

²ƘŜƴ ƛǘ ŀǎƪǎ ƛŦ ȅƻǳ ǿƛǎƘ ǘƻ ŎǊŜŀǘŜ ǘƘŜ ŘŀǘŀōŀǎŜ ŀǎ ƛǘ ŘƻŜǎƴΩǘ ŜȄƛǎǘ ŎƭƛŎƪ ȅŜǎ 

²ƘŜƴ ƛǘ ǊŜǘǳǊƴǎ ǘƻ ǘƘŜ ƭƻƎƛƴ ǎŎǊŜŜƴ ŜƴǘŜǊ ōƻǘƘ ǘƘŜ ǳǎŜǊƴŀƳŜ ŀƴŘ ǇŀǎǎǿƻǊŘ ŀǎ ΨŀǊƎƻƴŀǳǘΩ ŀƴŘ ŎƭƛŎƪ Ψ[ƻƎƛƴΩ 

You should now be in ok 

 

0.1.2 Bellerophon HD Lite installation 

 

Run Install.exe as administrator 

 In Windows Vista  wƛƎƘǘ ŎƭƛŎƪ ŀƴŘ ŎƭƛŎƪ Ψwǳƴ ŀǎ !ŘƳƛƴƛǎǘǊŀǘƻǊΩ 

 In Windows XP  wƛƎƘǘ ŎƭƛŎƪ ŀƴŘ ŎƭƛŎƪ Ψwǳƴ ŀǎΦΦΦΩ 

    {ŜƭŜŎǘ ǘƘŜ Ψ¢ƘŜ CƻƭƭƻǿƛƴƎ ¦ǎŜǊΩ ǊŀŘƛŀƭ ǎŜƭŜŎǘƛƻƴ 

    Enter the administrator log in details 

Select a location to install to using the Browse button 

/ƭƛŎƪ ǘƘŜ ΨLƴǎǘŀƭƭΩ ōǳǘǘƻƴ 

²ƘŜƴ ƛǘ ŀǎƪǎ ƛŦ ȅƻǳ ǿƛǎƘ ǘƻ ƛƴǎǘŀƭƭ ǘƘŜ ŀǇǇƭƛŎŀǘƛƻƴ ŎƭƛŎƪ ƻƴ ΨLƴǎǘŀƭƭΩ ŀƎŀƛƴ 

You should now see the log in screen 

Make sure the options are visible 

Place ŀ ǘƛŎƪ ƴŜȄǘ ǘƻ Ψ/ƘŀƴƎŜ {ŜǊǾŜǊ bŀƳŜΩ 

Enter your SQL server name or the name of your SQL Express instance i.e. (MYCOMPUTER\SQLEXPRESS) 

Enter a username and password that has access on your SQL to create a database 

/ƭƛŎƪ ǘƘŜ Ψ[ƻƎƛƴΩ ōǳǘǘƻƴ 

When it asks if you ǿƛǎƘ ǘƻ ŎǊŜŀǘŜ ǘƘŜ ŘŀǘŀōŀǎŜ ŀǎ ƛǘ ŘƻŜǎƴΩǘ ŜȄƛǎǘ ŎƭƛŎƪ ȅŜǎ 

²ƘŜƴ ƛǘ ǊŜǘǳǊƴǎ ǘƻ ǘƘŜ ƭƻƎƛƴ ǎŎǊŜŜƴ ŜƴǘŜǊ ōƻǘƘ ǘƘŜ ǳǎŜǊƴŀƳŜ ŀƴŘ ǇŀǎǎǿƻǊŘ ŀǎ ΨŀǊƎƻƴŀǳǘΩ ŀƴŘ ŎƭƛŎƪ Ψ[ƻƎƛƴΩ 

You should now be in ok 
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If you get the error unable to create registry keys or there are nƻ ƻǇǘƛƻƴǎ ƛƴ ǘƘŜ Ψ{ŜǊǾŜǊ bŀƳŜΩ ŀƴŘ Ψ5. 

bŀƳŜΩ drop down menus follow these steps first 

 

hǇŜƴ ǘƘŜ ΨIŜƭǇŘŜǎƪ YŜȅΦǊŜƎΩ ŦƛƭŜ from the downloaded ZIP in notepad 

wŜǇƭŀŎŜ Ψ9ƴǘŜǊ ȅƻǳǊ {v[ ǎŜǊǾŜǊ ƴŀƳŜ ƘŜǊŜΩ ǿƛǘƘ ȅƻǳǊ {v[ {ŜǊǾŜǊ ƴŀƳŜ 

wŜǇƭŀŎŜ Ψ9ƴǘŜǊ ȅƻǳǊ ŘŀǘŀōŀǎŜ ƴŀƳŜ ƘŜǊŜΩ ǿƛǘƘ ȅƻǳǊ ŎƘƻǎŜƴ ŘŀǘŀōŀǎŜ ƴŀƳŜ 

If you require multiple databases you need to enter the database names separated by commas 

(databse1,database2,database3,etc) 

Close and save the reg file making sure the file extension is still .reg 

Double click on the ƴŜǿƭȅ ǳǇŘŀǘŜŘ ΨIŜƭǇŘŜǎƪ YŜȅΦǊŜƎΩ ŦƛƭŜ ǘƻ ǳǇŘŀǘŜ ȅƻǳǊ ǊŜƎƛǎǘǊȅ ƪŜȅǎ 

Try again and it should work fine now 
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0.2 Bellerophon HD Quick Setup Guide 

 

Although some settings will be populated automatically you will need to configure the following screens for 

Bellerophon HD to run smoothly 

 

Bellerophon icon -> System Options 

Staff/Users - Add Staff members and create user logins - Level 10 users bypass all button protection, a 

valid email address is needed for emails to be sent correctly 

Currency Maint ς Add additional currencies 

Divisions / Customer Type ς Add additional divisions and customer types 

Sales Outlet ς Add your sales outlet details 

Company Information ς Add your company information 

Lookup Maintenance ς The lookup table allows you to add or edit the relevant tables 

Customer Credit Codes ς These are the payment types 

Customer Age Brackets ς These are the age brackets 

Customer Contact Titles ς These are the customer titles 

Customer Country Codes ς These are the country codes 

Customer Source Master/Details Info ς These are the source details 

Customer Status Codes ς These are the customer statuses 

Document Store File Types ς These are the document extensions 

Email Server Setting ς This is your email server and the email mail address that the help desk 

emails are sent from ς These are required for emails to be sent 

Help Desk SLAs ς These are the service level agreements 

Staff Department ς These are the departments 

User Options -> My Customisation ς Customise the look and feel of Bellerophon HD and the default printers 

Help Desk -> Customers ς Create new customers 

Help Desk -> Help Desk -> Maintenance 

Type Maintenance ς Create new custom fields and sub types 

Department Maintenance ς  Add / Remove users from the department 

    Allow users to edit estimated completion dates 

    Set the Job Completion target 

    Set the Default Job Type 

    Add any Additional Email Footer Text 

    Set the Overdue Job Gauge Maximum Value 

Enable / Disable Departments ς Enable or disable departments 

SLA Maintenance ς Setup the service level agreements so the days left will automatically be 

calculated when logging a job 

Job Status Maintenance ς Add additional helpdesk status and set others to be included or not 
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1. Summary 
 
1.1 What this screen is used for 
 
Viewing at a glance the summary of the statistics for the selected departments helpdesk 
 
Changing the summary to view  
 
1.2 Understanding the screen 
 

 
 

 
Summary to view 
These radial selections allow you to pick which summary you wish to view 

Total Helpdesk Users 
This shows the total amount of helpdesk users for the selected department 

Total Helpdesk Users Logged In 
This shows the total amount of helpdesk users currently logged in for the selected department 

Total Jobs 
This shows the job total for the selected summary 

Total Overdue Jobs 
This shows total amount of overdue jobs for the summary selected 

Total Open Jobs 
This shows the open job total for the selected summary 

Percentage of Jobs Completed On Time 
This meter shows the total amount of jobs completed on time for the selected summary 

Total Completed Jobs 
This shows the completed job total for the selected summary 

Total Cancelled Jobs 
This shows the cancelled job total for the selected summary 

Total Jobs Being Monitored 
This shows the being monitored job total for the selected summary 

Total Jobs Being Actioned 
This shows the being actioned job total for the selected summary 

 

1.3 Using the screen 

 
1.3.1 - This screen is for viewing easy to see figures for the selected summary on the selected ŘŜǇŀǊǘƳŜƴǘΩǎ 
helpdesk. To change the summary use the radial selections at the top left of the screen, you can choose 
between All, this month, last month, this year and last year (the figures change automatically to reflect your 
selection) 
 

1.3.2 - To switch between departments you need to cƭƛŎƪ ǘƘŜ άSelect Departmentέ button to select a new one 

from the list 
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2. Jobs 
 
2.1 What this screen is used for 
 
Creating staff or customer jobs assigned to a specific person with relevant data 
 
Updating existing jobs 
 
Viewing existing job details and job history 
 
Viewing jobs in a easy to view, colour coded, list format (Red ς Overdue, Yellow ς Due, Green ς Not Due) 
 
Exporting all jobs, selected job details or selected rows for database usage 
 
Filtering the list including hiding and showing Cancelled orders 
 
Switching Departments 
 
Adding documents and files to jobs and updating these files with newer versions 
 
2.2 Understanding the screen 
 
2.2.1 Title Bar ς Edit 
 

 
 
New 
This button allows you to clear the job details below to place a new job 

Update 
Click this button to update and edit the selected job 

Export To File 
This button exports the details of the jobs in the list to a text file 

 
2.2.2 Title Bar ς Filter 
 

 
 
Filter Jobs 
Click this button to filter the jobs using the selected information 

Reset Filters 
Click here to clear any filters entered and return to the default filter 

Given To 
This allows you to select which person a job was assigned to 

Status is (not) 
This allows you to select either if a status is or if a status is not the selected status 

SLA 
This allows you to select which SLA you wish to filter 

Request From Staff Member 
This allows you to select which staff member logged the job 

Request From Customer 
This allows you to select which customer logged the job 

Show Cancelled 
This tick box allows you to show or hide cancelled orders 

Date Type 
This allows you to select the date type to select 

Date From 
This allows you to select the date from 

Date To 
This allows you to select the date to 

Custom fields 
These fields are custom ŦƛŜƭŘΩǎ setup for each specific helpdesk 

 
2.2.3 Title Bar ς View 
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Select Department 
This button allows you to select which department you wish to view 

 
2.2.4 Title Bar ς Search 
 

 
 
Find Job No 
This allows you to search for a specific job number 

Search Problem Info 
This allows you to enter text to search for in the problem info of all the jobs 

Find similar Jobs 
This button allows you to find similar jobs to the one selected 

 
2.2.5 Title Bar ς When adding or updating a job 

 

 
 
Add / Save Changes 
This button allows you to add or save the changes made to an existing job 

Cancel 
This button allows you to cancel any changes made 

 
2.2.6 Help Desk Jobs tab 
 

 

 
When a Customer Request 

Customer No 
This shows the customer number 

Customer Name 
This shows the customer name 

When a Staff Request 
Request From 
This shows who requested this job 

Assigned to 
This shows who the job is assigned to 

Logged By 
This shows who logged the job initially 
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Status 
This shows the current status of the job 

SLA 
This shows the current SLA for the job 

Days Left 
This shows the number of days left until the job passes its estimated completion date 

Est Comp Date 
This shows the estimated completion date for this job 

Last Update 
This shows the date the last time the job was updated 

Staff / Customer Request 
These radial selections show which type of job this is (staff or customer) 

Reminder 
This tick box and date selector allow you to setup a reminder for the selected job 

Job No 
This shows the job number 

Job Description 
This job description is listed here 

Custom Fields 
Any custom ŦƛŜƭŘΩǎ setup will be displayed here and the relevant data can be stored here 

Problem 
This shows the problem / job info and any updates that have been made to this job 

Add Problem Info 
This drop down text entry box allows you to add problem info to the selected job 

When Adding or Updating a job 
Send Assignment Email After Save 
This tick box indicates that an assignment email needs to be sent when any changes are saved / a new job is added 

Send Confirmation Email After Save 
This tick box indicates that a confirmation email needs to be sent to the staff member or customer who originally requested the job when any changes are saved / a new 
job is added 

Jobs List 
This shows a the list of jobs for the filter options selected in the title bar, this can also be filtered using the controls in the column titles 

Refresh 
This button refreshes the job list in case there have been any changes 

< 
This button shows the job details for the previous order in the list from the selected order 

> 
This button shows the job details for the next order in the list from the selected order 

Select All 
This button selects all the orders in the list above 

Export Selected Rows 
Click this button to export the highlighted rows, these can then be pasted into another application like excel 

Open Jobs 
This button shows only the open jobs (open, monitoring and actioned) 

 

2.3 Using the screen 

 

2.3.1 - ¢ƻ ǾƛŜǿ ŀ Ƨƻōǎ ŘŜǘŀƛƭǎ ȅƻǳ Ŏŀƴ ǎŜƭŜŎǘ ƛǘ ŦǊƻƳ ǘƘŜ Ƨƻōǎ ƭƛǎǘ ƻƴ ǘƘŜ ǊƛƎƘǘ όōȅ ŘŜŦŀǳƭǘ ǘƘƛǎ ŘƻŜǎƴΩǘ ǎƘƻǿ 

Completed or Cancelled orders), you can browse through the jobs one by one using the άғέ and άҔέ buttons to 

go back and forward by 1 job each click. To find a specific job you need to ǎŜƭŜŎǘ ǘƘŜ ά{ŜŀǊŎƘέ tab at the top 

then ŜƴǘŜǊ ǘƘŜ Ƨƻō ƴǳƳōŜǊ ƛƴǘƻ ǘƘŜ άCƛƴŘ Wƻō bƻέ box and press return. TƘŜ ά{ŜŀǊŎƘ tǊƻōƭŜƳ LƴŦƻέ box allows 

you to search all jobs for the problem information enteredΦ ¢ƘŜ άSearch Legacy Noέ is only used when 

searching on jobs imported from another helpdeskΦ ¸ƻǳ Ŏŀƴ ǾƛŜǿ ǘƘŜ άtǊƻōƭŜƳ LƴŦƻέ ƻŦ ŀ Ƨƻō ƛƴ ŀ ƴŜǿ ǿƛƴŘƻǿ 

by double clicking on it 

 

2.3.2 - If you wish to adjust the filter you Ŏŀƴ Řƻ ǘƘƛǎ ŦǊƻƳ ǘƘŜ άCƛƭǘŜǊέ tab on the task bar, click on it to view it. 

By default the only ŦƛƭǘŜǊ ǘƘŀǘ ƛǎ ŜƴŀōƭŜŘ ƛǎ ǘƘŜ άStatus is not CompleǘŜέ. The άGiven ToέΣ άStatus isέ and άSLAέ 

can all be changed to their opposite by clicking on them (click on άSLAέ changes it to άSLA is notέ ŜǘŎ, click on it 

again to change it back). You can select the filter options using the drop down lists, once you have select all 

these click the άFilter Jobsέ button to action the filter (the results are shown in the jobs list below). The άReset 

CƛƭǘŜǊǎέ button clears all the filters so all jobs (except cancelled) are shown in the jobs list below, to show 

cancelled orders yoǳ ƴŜŜŘ ǘƻ ǇƭŀŎŜ ŀ ǘƛŎƪ ƴŜȄǘ ǘƻ ά{Ƙƻǿ /ŀƴŎŜƭƭŜŘέ then click the άFilter Jobsέ button again 

 

2.3.3 - To switch between departments you need to click into the άViewέ tab on the taskbar then click the 

άSelŜŎǘ 5ŜǇŀǊǘƳŜƴǘέ button to select from the list 
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2.3.4 - To create a new job you need to click the άbŜǿέ button in the άEditέ tab on the taskbar, once you have 

done this the ά!ŘŘέ ŀƴŘ ά/ŀƴŎŜƭέ buttons will appear on the taskbar. You need to enter all the information 

below and populate all required fields (fields that need to be entered for a job to be logged). Once you have 

populateŘ ŀƭƭ ǘƘŜ ƴŜŎŜǎǎŀǊȅ ŦƛŜƭŘǎ ǘƘŜ ά9ǎǘ /ƻƳǇ 5ŀǘŜέ ŀƴŘ ǘƘŜ άDays Leftέ are calculated automatically using 

the SLAs entered. You then need to enter alƭ ǘƘŜ Ƨƻō ƛƴŦƻǊƳŀǘƛƻƴ ƛƴǘƻ ǘƘŜ άAdd Problem LƴŦƻέ ǎŜŎǘƛƻƴ ŀƴŘ ŎƭƛŎƪ 

OKΦ ¢ƘŜ άSŜƴŘ !ǎǎƛƎƴƳŜƴǘ 9Ƴŀƛƭ !ŦǘŜǊ {ŀǾŜέ ŀƴŘ άSenŘ /ƻƴŦƛǊƳŀǘƛƻƴ 9Ƴŀƛƭ !ŦǘŜǊ {ŀǾŜέ are both ticked 

automaǘƛŎŀƭƭȅΣ ǘƘŜǎŜ Ŏŀƴ ōŜ ǳƴǘƛŎƪŜŘ ƛŦ ȅƻǳ ŘƻƴΩǘ ǿŀƴǘ ǘƘŜǎŜ ŜƳŀƛƭǎ ǘƻ ōŜ ǎŜƴǘΦ hƴŎŜ ȅƻǳ ƘŀǾŜ ŦƛƴƛǎƘŜŘ 

entering the details click ǘƘŜ άAddέ button in the taskbar to save the changes, send the automatic emails, 

assign a job number and add it to the jobs list on the right. If you wish to close the job without saving it click 

ǘƘŜ ά/ŀƴŎŜƭέ button on the taskbar and all changes will be discarded 

2.3.5 - If you wish to update an existing job you need to select it from the list so the details of the job are 
populated on ǘƘŜ ƭŜŦǘ ǘƘŜƴ ŎƭƛŎƪ ǘƘŜ ά¦ǇŘŀǘŜέ button in the ά9Řƛǘέ tab on the taskbar, once you have done this 
ǘƘŜ ά{ŀǾŜ /ƘŀƴƎŜǎέ ŀƴŘ ά/ŀƴŎŜƭέ buttons will appear on the taskbar. Once you have made any changes or 
added any additional problem information ȅƻǳ ƴŜŜŘ ǘƻ ŎƭƛŎƪ ǘƘŜ ά{ŀǾŜ /ƘŀƴƎŜǎέ button to save any changes, 
to discarŘ ŀƴȅ ŎƘŀƴƎŜǎ ŎƭƛŎƪ ǘƘŜ ά/ŀƴŎŜƭέ button 
 
2.3.6 - There are a 2 main ways of exporting data from the help desk 

¶ ¢ƘŜ ŦƛǊǎǘ ƛǎ ǳǎƛƴƎ ǘƘŜ άExport to Fileέ button in the άEditέ tab on the taskbar, when you click this you 
are prompted for a name and location to save the file. This exports all the jobs including the problem 
information to a text document 

¶ The secoƴŘ ƛǎ ǘƘŜ ά9ȄǇƻǊǘ {ŜƭŜŎǘŜŘ wƻǿǎέ button underneath the jobs list, you need to highlight the 
rows in the jobs list ƻǊ ŎƭƛŎƪ ǘƘŜ ά{ŜƭŜŎǘ !ƭƭέ button to highlight them all then click the button to export 
the job details to the clipboard (all apart from the problem information) you can then paste these into 
another problem such as excel for reporting purposes 

 
2.4 Job Documents tab 

 

 

 
Ref Code 
This shows the entered ref code 

Document Search All 
This button allows you to search all documents attached to any job ǳǎƛƴƎ ǘƘŜ ŜƴǘŜǊŜŘ άwŜŦ /ƻŘŜέ 

Document Job Search 
This button allows you to search only documents attached to this job ǳǎƛƴƎ ǘƘŜ ŜƴǘŜǊŜŘ άwŜŦ /ƻŘŜέ 

Add 
Click this button to add a new document to the selected job ǳǎƛƴƎ ǘƘŜ ΨwŜŦ /ƻŘŜΩ ŜƴǘŜǊŜŘ 

Update 
Click this button to update the selected document with a new version 

Remove Version 
Select a version from the list on the right and click this button to remove it 

Save Copy Of Document 
This allows you to save a copy of the selected document version to view and edit 

Document List 
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This shows the list of documents attached to the selected job by default (or the results from a search) 

Version List 
This shows the different versions of the selected document above 

 

2.5 Using the screen 

 

2.5.1 - The document display section automatically shows the documents attached to the selected order by 

default, you can search these documeƴǘǎ ōȅ ǘȅǇƛƴƎ ǎƻƳŜǘƘƛƴƎ ƛƴ ǘƘŜ άRef Codeέ box then clicking the 

ά5ƻŎǳƳŜƴǘ /ǳǎǘ {ŜŀǊŎƘέ buttonΦ LŦ ȅƻǳ ǿƛǎƘ ǘƻ ǎŜŀǊŎƘ ŀƭƭ ŎǳǎǘƻƳŜǊ ŘƻŎǳƳŜƴǘǎ ŎƭƛŎƪ ǘƘŜ ά5ƻŎǳƳŜƴǘ {ŜŀǊŎƘ !ƭƭέ 

button instead 

 

2.5.2 - To view the different versions of a document click on it and the versions of that document will be 

displayed below. To open and save one of these versions to your computer you need to highlight it from the 

document versions section then cƭƛŎƪ ǘƘŜ ά{ŀǾŜ /ƻǇȅ hŦ 5ƻŎǳƳŜƴǘέ button, this will then open a new window 

allowing you to select where you wish to save the document and what you want to call it 

 

2.5.3 - If you wish to add a new document to this order you neeŘ ǘƻ ŜƴǘŜǊ ǘƘŜ ƴŜǿ ƴŀƳŜ ƛƴ ǘƘŜ άReŦ /ƻŘŜέ 

field then click tƘŜ άAddέ button, this then opens a window to select a document to upload. Once you have 

uploaded this it will appear in the document display section 

 

2.5.4 - If you wish to update a document with a new version, you need to select the document from the list 

ǘƘŜƴ ŎƭƛŎƪ ǘƘŜ ά¦ǇŘŀǘŜέ button, this opens up a new window allowing you to select a later version of the 

selected document (this needs to have the same name as the original file) 

 

2.5.5 - To remove a version of a document you need to select the document, then select the version of the 

document you wish to remove ǘƘŜƴ ŎƭƛŎƪ ǘƘŜ άwŜƳƻǾŜ ±ŜǊǎƛƻƴέ button 
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3. Scheduler 
 
3.1 What this screen is used for 
 
Viewing jobs in a list and an outlook express style calendar view 
 
Filtering jobs 
 
Opening and viewing jobs in separate windows 
 
Opening jobs to amend them using the job viewing window 
 
Viewing the schedule in various views (week, month or timeline) 
 
Viewing a job in the calendar view using the list on the left 
 
3.2 Understanding the screen 
 

 

 
In the View tab 

Go To Date 
This date selector allows you to select a date to jump to on the calendar view 

Scheduler View 
This allows you to select the time scale shown on the calendar view  

Selected Department 
This button allows you to select a different department to view 

In the Filter tab 
Filter Jobs 
Click this button to filter the jobs using the selected information 

Reset Filters 
Click here to clear any filters entered and return to the default filter 

Given To 
This allows you to select which person a job was assigned to 

Status is (not) 
This allows you to select either if a status is or if a status is not the selected status 

SLA 
This allows you to select which SLA you wish to filter 

Request From Staff Member 
This allows you to select which staff member logged the job 

Request From Customer 
This allows you to select which customer logged the job 

Show Cancelled 
This tick box allows you to show or hide cancelled orders 

Updated Date From 
This allows you to select the update date from 

Updated Date To 
This allows you to select the update date to 

Custom fields 
These fields are custom ŦƛŜƭŘΩǎ setup for each specific helpdesk 


